
Utilización de Xen-Server para configurar  un servicio(Serva) 
que permita la instalación de un sistema operativo Windows 
10 por PXE(tarjeta de red).

Wikipedia:Preboot eXecution Environment (PXE) (Entorno de ejecución de prearranque), es 
un entorno para arrancar e instalar el sistema operativo en computadoras a través de una red, de 
manera independiente de los dispositivos de almacenamiento de datos disponibles (como discos 
duros) o de los sistemas operativos instalados. 

1. Instalación y configuración de la máquina cliente XenCenter

2. Instalación de Serva en la máquina virtual Windows 10 creada en Xen-Server.

3. Configuración de Serva

4. Instalación de un sistema operativo  vía PXE en máquina virtual VirtualBox y en una
máquina real.

5. Configuración de un servidor DHCP.
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1.- Instalación y configuración de la máquina cliente XenCenter.

Configuración de la ip en la  máquina donde ejecutamos Citrix XenCenter. 
Configuramos una Ip 4 que no permite acceder a la maquina que tiene instalado el servidor 

Citrix  Xen Server. 
Tenemos instalada una maquina servidor  en la Ip 192.168.81.6 con el nombre lahuerce

Instalación de Citrix  XenCenter. 
Una vez descargado el fichero de instalación, es fácil ejecutar y realizar la instalación.
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Para conectarnos con el servidor picamos en Add a Server y configuramos el acceso a 
XenServer indicando la Ip , usuario y contraseña. 
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2. Instalación de Serva en la máquina virtual Windows 10 creada en Xen-
Server.

En el servidor tenemos una maquina virtual Windows 10 Profesional sobre el que vamos a 
configurar el servidor PXE Serva Comunity.

Serva  se descarga desde https://www.vercot.com/~serva/download.html ,
Serva se distribuye  como  versión profesional(de pago) y  gratuita Community que es la 

que vamos a utilizar.

Para instalar Serva lo único que necesitamos es descargar el fichero .zip y descomprimirlo 
en la carpeta C:\Serva.  Ahora tenemos que crear una carpeta con el nombre Sos.  En esta carpeta el
proceso de configuración de Serva  creara las carpetas en la cuales copiaremos los ficheros 
necesarios para instalar el sistema operativo(se obtienen del fichero ISO de isntalacion del sistema 
operativo). En nuestro caso queremos trabajar con Windows 10.

Serva necesita el apoyo de un servidor DHCP. Para el proceso que vamos a describir 
utilizaremos un servidor DHCP instalado en un disco  NAS, que monta un servicio de DHC. Este 
servidor se utiliza para asignar una IP a las tarjetas de red de los PC que detecte el servidor Serva.

Una alternativa a utilizar un disco NAS como servidor  es montar en SenServer un sevidor 
DHCP.
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3. Configuración de Serva.

Para realizar la instalación ejecutamos la versión de Serva de acuerdo al tipo del equipo 
servidor (32 o 64). En nuestro equipo ejecutamos Serva64.

Lo primero que se  muestra es la elección del tipo de servidor Serva a ejecutar (Profesional o
Community).

Seleccionamos la versión Community.

Para entrar en la configuración es necesario clikar en el icono y seleccionar Setting.

Se visualiza la pantalla con las opciones de configuración.
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En la pestaña TFTP la configuramos con los siguientes parámetros.

Explicación de los parámetros configurados.
Marcamos la opción TFTP Server
Bind TFTP to this addres, indica la IP del equipo donde tenemos instalado Serva
TFTP Server root directory añadimos la ruta de la carpeta de instalación c:\serva\SOs, ya 
lo tenemos configurado
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Las opciones de la pestaña DHCP

Explicación de los parámetros configurados.
Marcamos la opción DHCP Server
Marcamos la opción BINL
Bind DHCP to this addres, la IP del equipo donde estamos instalando SERVA

IP Pool 1st addr  Indica el valor de la primera Ip que se asignara a los equipos clientes que
se quieran conectar por tarjeta de red(PXE)
Pool Size , nº de conexiones máximas permitidas.
Net Server Automatic
Boot File, el fichero que se ejecutará para cargar la imagen dependiendo del sistema
 operativo seleccionado
 \BM\PXESERVA\BIOS\pxeserva.0|6?\BM\PXESERVA\EFI32\pxeserva.efi|
7?\BM\PXESERVA\EFI64\pxeserva.efi|9?\BM\PXESERVA\EFI64\pxeserva.efi
La instalación y configuración del programa serva  ha realizado esta tarea  de forma 
automática.
Subnet Mask , la mascara de red correspondiente a la Ip configurada.
Router , Ip de una máquina que tenga activado un servidor DHCP, en nuestro caso
contamos con un disco NAS externo que tiene un serviodor DHCP instalado,lo
utilizamos. También nos puede servir la IP de nuestro router de casa. Debemos de tener en
cuenta que la herramienta Serva  gratuita soporta un  numero pequeño de clientes a la vez.
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Configuración del servidor con los ficheros de instalación de Windows 10.

Si accedemos a la carpeta Sos veremos que se  ha creado la siguiente estructura de ficheros.

Como nosotros queremos configurar Serva para instalar máquina via PXE de Windows 10
en la carpeta WIA_WDS creamos la carpeta W10,por ejemplo.

Y en la misma descomprimimos la Iso de  Windows10.
Una opción muy útil esta en crear un fichero de instalación desatendida(autounattend.xml)

que  facilite la menor intervención del usuario a la hora de instalar muchos sistemas a la vez.
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Pues bien para que la carpeta de instalación sea accesible desde las máquinas cliente donde 
queremos isntalar el sistema operativo,  será necesario poner a compartir para todos los usuarios la 
carpeta WIA_WDS con dos nombres de red WIA_WDS y WIA_WDS_SHARE

Bien volvemos a ejecutar Serva64 y lo cerramos para que se configure con los ficheros de 
instalación de Windows 10 .

Ahora Cerramos la ventana de configuración, nos pedirá que cerremos el programa y lo
volvemos a ejecutar en espera que le lleguen peticiones desde los equipos cliente.
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Una vez terminada la actualización ejecutamos de nuevo Serva64 para poner en 
funcionamiento el servidor. Vemos como el servidor esta en ejecución.
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4.- Instalación de un sistema operativo  vía PXE en máquina virtual VirtualBox 
y en una máquina real.

A la hora de explotar el servicio lo vamos a hacer con una maquina virtual creada en 
VirtualBox y desde un equipo real en el que será necesario establecer en la Bios el arranque por 
PXE.

Instalación de Windows 10 en una maquina virtual VirtualBox por PXE.

Para ello instalamos Virtual Box en la máquina cliente. Creamos una máquina virtual de tipo
Windows y elegimos la versión del sistema operativo a instalar.

Al crear la máquina virtual se indica el tamaño del disco Virtual(20GB). Y se crea un 
fichero(w10.vdi) que virtualiza el disco donde se instalará Windows 10 en la máquina virtual.

El otro apartado donde hay que configurar la máquina virtual para la instalación vía PXE 
esta en la configuración de la tarjeta de red.

Primero el la opción   de Sistema indicamos en el orden de arranque, es necesario marcar la
opción de red en primer lugar. De esta forma el sistema operativo virtual buscar arrancar por PXE.
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Otro parámetro  de  red a configurar esta en la forma de conexión de la tarjeta de red. Es 
necesario establecer  Adaptador puente para que el servidor DHCP sea capaz de detectar la tarjeta 
de red y de esta forma asignarle una de las direcciones IP configuradas en el servidor Serva.

Pues nada. Ya solo queda comprobar que serva esta funcionado y lanzar(ejecutar la máquina 
virtual creada en Virtual Box)

Serva funcionado.
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Ejecutando máquina virtual.

En la aplicación Serva se visualizan los siguientes mensajes:
LA IP ASIGNADA A LA MAQUINA CLIENTE QUE ha solicitado conexión

Conexiones TFTP 

Progreso de la CONEXION 
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En la ventana de la máquina cliente Virtual Box, si todo va bien , aparece un menú que nos 
permite elegir el sistema operativo a instalar entre todos los que hemos configurado(en nuestro caso
solo hemos configurado Windows 10):

La máquina cliente conecta con el servidos(carpeta copartida) utilizando la Ip que se le ha 
asignado vía DCHP.

Lo que solicita  esta  pantalla es la clave de la máquina virtual Windows 10 creada en 
XENServer, en la que se esta ejecutando el servicio Serva.(admin,admin).
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Si tenemos algún problema de conexión(botón Connect) podemos acceder a una consola 
para solucionar o investigar que ocurre.

Si ha funcionado la conexión el comando net use nos muestra la unidad de red asignada a la 
carpeta compartida que contiene los ficheros de instalación:
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Solo queda seguir el proceso de instalación. Si hemos configurado  una instalación 
desatendida, esta se encargará de responder a las preguntas del instalador de Windows 10:.

Fichero de instalación desatendida.
<?xml version="1.0" encoding="utf-8"?>
<unattend xmlns="urn:schemas-microsoft-com:unattend">
    <settings pass="windowsPE">
        <component name="Microsoft-Windows-Setup" processorArchitecture="amd64" 
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS" 
xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
            <DiskConfiguration>
                <Disk wcm:action="add">
                    <CreatePartitions>
                        <CreatePartition wcm:action="add">
                            <Order>1</Order>
                            <Size>200</Size>
                            <Type>Primary</Type>
                        </CreatePartition>
                        <CreatePartition wcm:action="add">
                            <Extend>true</Extend>
                            <Order>2</Order>
                            <Type>Primary</Type>
                        </CreatePartition>
                    </CreatePartitions>
                    <ModifyPartitions>
                        <ModifyPartition wcm:action="add">
                            <Active>true</Active>
                            <Format>NTFS</Format>
                            <Label>Sistema</Label>
                            <Order>1</Order>
                            <PartitionID>1</PartitionID>
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                        </ModifyPartition>
                        <ModifyPartition wcm:action="add">
                            <Active>true</Active>
                            <Format>NTFS</Format>
                            <Label>Windows 10</Label>
                            <Letter>C</Letter>
                            <Order>2</Order>
                            <PartitionID>1</PartitionID>
                        </ModifyPartition>
                    </ModifyPartitions>
                    <DiskID>0</DiskID>
                    <WillWipeDisk>true</WillWipeDisk>
                </Disk>
            </DiskConfiguration>
            <ImageInstall>
                <OSImage>
                    <InstallTo>
                        <DiskID>0</DiskID>
                        <PartitionID>2</PartitionID>
                    </InstallTo>
                </OSImage>
            </ImageInstall>
            <UserData>
                <ProductKey>
                    <Key>NFW3X-CPGV4-FKH9F-WXJGJ-K2FC6</Key>
                    <WillShowUI>OnError</WillShowUI>
                </ProductKey>
                <AcceptEula>true</AcceptEula>
            </UserData>
        </component>
        <component name="Microsoft-Windows-International-Core-WinPE" processorArchitecture="amd64" 
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS" 
xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
            <SetupUILanguage>
                <UILanguage>es-ES</UILanguage>
            </SetupUILanguage>
            <InputLocale>es-ES</InputLocale>
            <SystemLocale>es-ES</SystemLocale>
            <UILanguage>es-ES</UILanguage>
            <UserLocale>es-ES</UserLocale>
        </component>
    </settings>
    <settings pass="specialize">
        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="amd64" 
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS" 
xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
            <OEMInformation>
                <Manufacturer>CIFP Santa Catalina</Manufacturer>
                <HelpCustomized>false</HelpCustomized>
                <SupportPhone>947500469</SupportPhone>
                <SupportAppURL></SupportAppURL>
                <SupportHours>8-18</SupportHours>
                <SupportURL>www.fpsantacatalina.com</SupportURL>
            </OEMInformation>
            <AutoLogon>
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                <Password>
                    <Value>cwBhAG4AdABhAGMAYQB0AGEAbABpAG4AYQBQAGEAcwBzAHcAbwByAGQA</Value>
                    <PlainText>false</PlainText>
                </Password>
                <Enabled>true</Enabled>
                <LogonCount>5</LogonCount>
                <Username>Administrator</Username>
            </AutoLogon>
            <ComputerName>Izquierda</ComputerName>
        </component>
    </settings>
    <settings pass="oobeSystem">
        <component name="Microsoft-Windows-Shell-Setup" processorArchitecture="amd64" 
publicKeyToken="31bf3856ad364e35" language="neutral" versionScope="nonSxS" 
xmlns:wcm="http://schemas.microsoft.com/WMIConfig/2002/State" xmlns:xsi="http://www.w3.org/2001/XMLSchema-
instance">
            <UserAccounts>
                <AdministratorPassword>
                    
<Value>cwBhAG4AdABhAGMAYQB0AGEAbABpAG4AYQBBAGQAbQBpAG4AaQBzAHQAcgBhAHQAbwByAFAAYQBzAHMA
dwBvAHIAZAA=</Value>
                    <PlainText>false</PlainText>
                </AdministratorPassword>
            </UserAccounts>
            <OOBE>
                <HideEULAPage>true</HideEULAPage>
                <SkipMachineOOBE>true</SkipMachineOOBE>
                <SkipUserOOBE>true</SkipUserOOBE>
            </OOBE>
        </component>
    </settings>
    <cpi:offlineImage cpi:source="wim:e:/desatendida/sources/install.wim#Windows 10 Pro" xmlns:cpi="urn:schemas-
microsoft-com:cpi" />
</unattend>
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Instalación vía PXE desde en una máquina real.

El proceso es exactamente igual que para la máquina virtual.

Lo primero será entrar a la bios del ordenador, habilitar PXE y arranque por tarjeta de red.

Cuando arranca el equipo habilitar el menú de Arranque y seleccionar la tarjeta de red.

El ordenador cliete se conecta al servidor Serva por medio de la Ip asignada por DHCP.

Seleccionar el sistema operativo a instalar. En este caso solo se muestra una opción ya que 
solamente hemos preparado una versión con Windows 10.
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Lo que solicita es la clave de la máquina virtual Windows 10 creada en XENServer, en la 
que se esta ejecutando el servicio Serva.(admin,admin).

Si tenemos algún problema de conexión(botón Connect) podemos acceder a una consola 
para solucionar o investigar que ocurre.

Se muestra  la primera pantalla de instalación de windows 10. De tener un fichero de 
instalación desatendida, la instalación termina sin la intervención del usuario.
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5.- Configuración de un servidor DHCP.
En la configuración del servidor Serva hemos utilizado un disco NAS que nos proporciona 

un servicio de DHCP .
De no contar con este tipo de disco, e incluso es mejor opción, podemos configurar un 

servidor de DHCP. 
Este servicio lo vamos a instalar sobre un sistema Linux.

Para instalar el servidor de DHCP previamente  actualizamos el sistema con los comandos 
sudo apt upgrade y sudo apt update.

La instalación de DHCP se realiza desde un repositorio  por medio de la orden 
sudo apt install isc-dhcp-server

                               

        

 
Una vez instalado podemos comenzar a trabajar con él.
Iniciar el DHCP: 

service isc-dhcp-server start 
 
Se para con: 

service isc-dhcp-server stop 
 
Se reinicia con: 

service isc-dhcp-server restart 
 
Se ve su estado con: 

service isc-dhcp-server status
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Vemos como al ejecutar el comando service isc-dhcp-server status la aplicación falla. 
Esto es debido a que no esta configurado.
     

Tras haber instalado en Linux el servidor DHCP, en el sistema de archivos se han creado 
varios archivos relacionados con la administración y configuración del servicio. Es necesario   
conoceer donde se encuentran esos archivos, cuál es su nombre, que función tienen y como se 
pueden modificar o interpretar.  Los archivos y directorios más importantes relacionados con el 
servicio DHCP en Ubuntu son: 
 

 Directorio /etc/dhcp: Contiene archivos de configuración relacionados con el servicio 
DHCP. El principal de los archivos es dhcpd.conf. 

 Archivo /etc/dhcp/dhcpd.conf es el archivo de configuración del servidor. En el siguiente 
apartado describiremos cual es la sintaxis de este archivo. 

 Archivo /etc/dhcp/dhclient.conf es un archivo de configuración del cliente DHCP. Se 
encuentra en cualquier ordenador con Ubuntu que tenga el cliente DHCP instalado. Su 
contenido indica cómo se comporta el cliente cuando solicita el servicio DHCP. Por 
ejemplo, en el archivo se indican cuáles son los parámetros de red que solicita el cliente a 
los servidores DHCP. 

 
 Archivo /etc/init.d/isc-dhcp-server es, un script para iniciar y detener el servicio. 

 Archivo /etc/default/isc-dhcp-server establece los interfaces de red por los que el servidor 
DHCP atiende o escucha a los clientes. 

 Archivo /var/lib/dhcp/dhcpd.leases contiene información actualizada sobre las 
concesiones que ha otorgado el servidor a los clientes. Dentro de este archivo hay una 
entrada por cada concesión que se ha dado y en la que se indica la IP que se ha concedido al 
cliente, la dirección física del cliente, cuanto tiempo de concesión se ha utilizado, etc. 

 Archivo /usr/sbin/dhcpd es el archivo ejecutable correspondiente al servicio. Es un 
demonio que se encarga de escuchar las solicitudes de los clientes DHCP y controlar la 
entrega correcta de parámetros de red a los clientes. 

 Archivo /var/log/messages es un archivo de texto donde se registran los inicios y paradas 
de los servicios (registro de logs de servicios). Cuando se produzcan fallos al iniciar y 
detener el servicio DHCP debemos consultar la información que nos de este archivo sobre el
fallo producido para intentar solucionarlo.
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Configuración del servidor DCHP.

Primero vemos en que red está nuestro equipo:
      

Configuración básica del fichero dhcpd.conf
      

Básicamente definimos un ámbito, de 90 direcciones IP que serán más que suficientes. 
Además, establecemos la dirección de broadcast y la de la puerta de enlace

Establecemos la tarjeta de red que va a dar servicio DHCP por defecto   
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Una vez terminada la configuración reiniciamos el servicio y comprobamos que está 
levantado  
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